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Note pour les utilisateurs Mac
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Sélection de menu 
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Ctrl (Contrôle) ⌘ (Commande) Utilisé avec d'autres touches

F5 Maj+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles & Formatage

La documentation de LibreOffice est disponible sur www.libreoffice.org

http://www.libreoffice.org/
mailto:doc@fr.libreoffice.org
http://creativecommons.org/licenses/by/3.0/
http://www.gnu.org/licenses/gpl.html


Table des matières
Copyright......................................................................................................................................... 2

Note pour les utilisateurs Mac..........................................................................................................2

Éléments graphiques dans Calc.......................................................................................................4

Ajouter des images..........................................................................................................................4

Insérer un fichier image...............................................................................................................4
Boîte de dialogue Insérer une image......................................................................................4

Lier un fichier image....................................................................................................................5
Incorporer des images liées....................................................................................................6

Insérer une image depuis le presse-papiers................................................................................7

Insérer une image depuis la Gallery............................................................................................7

Modifier des images.........................................................................................................................8

Utiliser la barre d'outils Image.....................................................................................................8

Choisir un mode graphique.......................................................................................................10

Utiliser les filtres graphiques......................................................................................................10

Ajuster les couleurs...................................................................................................................11

Définir la transparence...............................................................................................................11

Personnaliser les lignes, les remplissages et les ombres..........................................................11

Rogner les images.....................................................................................................................11

Redimensionner une image.......................................................................................................13

Utiliser le menu contextuel d'une image.........................................................................................13

Texte..........................................................................................................................................13

Position et taille.........................................................................................................................13

Faire pivoter une image.............................................................................................................14

Taille d'origine............................................................................................................................15

Description................................................................................................................................15

Nom........................................................................................................................................... 15

Refléter......................................................................................................................................15

Assigner une macro...................................................................................................................16

Groupe......................................................................................................................................16

Utiliser les outils de dessin de Calc................................................................................................16

Paramétrer ou changer les propriétés des objets de dessin......................................................19

Redimensionner un objet de dessin..........................................................................................19

Grouper des objets de dessin....................................................................................................19

Positionner des éléments graphiques............................................................................................20

Organiser des éléments graphiques..........................................................................................20

Ancrer des éléments graphiques...............................................................................................21

Aligner les éléments graphiques................................................................................................22

Créer une image map....................................................................................................................22

Utiliser des Éléments graphiques dans Calc 3



Éléments graphiques dans Calc

Calc est souvent utilisé pour présenter des données et faire des budgets et des prévisions. Les 
éléments graphiques peuvent transformer un document quelconque en un document dont on se 
souvient. Calc peut importer différents formats de fichiers vectoriels (dessin de lignes) et matriciels 
(bitmap). Les formats graphiques les plus couramment utilisés sont GIF, JPG, PNG et BMP. Voir 
l'Aide pour la liste complète des formats que LibreOffice peut importer.

Les éléments graphiques dans Calc peuvent être regroupés en trois types :

• les fichiers d'image, comme les photos, les dessins et les images scannées

• les diagrammes créés avec les outils de dessin de LibreOffice

• les diagrammes et graphiques créés par les fonctions Diagrammes de LibreOffice

Ce chapitre couvre les images et les diagrammes. Les graphiques sont décrits Chapitre 3 (Créer 
des Diagrammes et des Graphiques).

Bien que l'usage des éléments graphiques dans Calc soit très similaire à l'usage des éléments 
graphiques dans d'autres composants de LibreOffice, ce chapitre explique certaines différences 
dans leur utilisation. Il couvre également certaines fonctions graphiques plus avancées et la façon 
dont elles peuvent améliorer en fin de compte votre classeur.

Note
L'expression éléments graphiques se réfère à la fois aux images et aux objets 
dessinés. Souvent le mot images est utilisé pour se référer aux images et autres 
éléments graphiques qui ne sont pas des objets dessinés.

Ajouter des images

Les images, comme des logos de sociétés ou des photographies de personnes ou de produits, 
sont probablement les types les plus courants d'éléments graphiques ajoutés à un document Calc. 
Ils peuvent être téléchargés depuis Internet, scannés ou créés avec des logiciels graphiques ; ou 
ce peuvent être des photos prises avec un appareil numérique.

Les images peuvent être insérées de trois manières :

• en utilisant la boîte de dialogue Insérer une image

• depuis la Gallery

• depuis le presse-papiers en copiant et collant

Insérer un fichier image
La manière la plus ordinaire d'insérer une image est peut-être d'utiliser un fichier existant. 

Pour insérer une image depuis un fichier, utilisez la boîte de dialogue Insérer une image.

Boîte de dialogue Insérer une image
1) Cliquez à l'endroit dans le document Calc où vous voulez que l'image apparaisse. Ne vous 

souciez pas trop du positionnement exact de l'image à cette étape ; l'emplacement pourra 
facilement être changé comme décrit dans “Positionner des éléments graphiques” page 20.

2) Choisissez Insertion > Image > À partir d'un fichier dans la barre de menus, ou cliquez 

sur l'icône À partir d'un fichier  dans la barre d'outils Image ou Dessin.

3) Dans la boîte de dialogue Insérer une image, naviguez jusqu'au fichier à insérer, 
sélectionnez-le et cliquez sur Ouvrir.
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Note

L'image est insérée dans Calc de sorte qu'elle flotte au-dessus des cellules et qu'elle 
soit ancrée à la cellule dans laquelle le focus était placé. Voir “Positionner des 
éléments graphiques” page 20 pour plus d'informations sur le positionnement et 
l'ancrage des éléments graphiques.

Figure 1 : Insérer une image depuis un fichier

En bas de la boîte de dialogue se trouvent deux options, Aperçu et Lier. Sélectionnez Aperçu 
pour afficher un aperçu de l'image sélectionnée sur la droite, ce qui vous permet de vérifier qu'il 
s'agit du bon fichier. L'option Lier est détaillée page 5 ci-dessous. Quand l'option Lier n'est pas 
cochée, l'image est enregistrée dans le document Calc.

Note
Votre boîte de dialogue Insérer une image peut être sensiblement différente de celle 
de la Figure 1, selon votre système d'exploitation et votre choix dans Outils > 
Options > LibreOffice > Général d'utiliser les boîtes de dialogue LibreOffice.

Lier un fichier image
Pour créer un lien vers le fichier qui contient l'image au lieu d'en enregistrer une copie dans le 
document Calc, utilisez la boîte de dialogue Insérer une image et cochez l'option Lier. Un 
message d'avertissement peut apparaître pour vous demander de confirmer cette liaison ou 
d'incorporer le fichier. L'image est alors affichée dans le document, mais quand le document est 
enregistré, il contient seulement une référence au fichier image, et non l'image elle-même. Le 
document et l'image demeurent dans deux fichiers séparés, qui seront fusionnés temporairement 
uniquement quand vous ouvrirez à nouveau le document.

Lier une image comporte deux avantages et un inconvénient :

• Avantage : vous pouvez modifier le fichier image séparément sans changer le document, 
parce que le lien vers le fichier reste valide, et l'image modifiée apparaîtra la prochaine fois 
que vous ouvrirez le document. Ce peut être un grand avantage si vous (ou quelqu'un 
d'autre, un graphiste par exemple) mettez à jour les images.

• Avantage : le lien peut réduire significativement la taille du document au moment de son 
enregistrement, parce que le fichier image lui-même n'est pas inclus. La taille de fichier 
n'est habituellement plus un problème sur les ordinateurs modernes qui ont une mémoire 
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de stockage conséquente, à moins que le document ne comporte de très gros fichiers 
graphiques. Calc peut supporter de gros fichiers.

• Inconvénient : Si vous envoyez le document à quelqu'un d'autre, ou si vous le déplacez 
vers un autre ordinateur, vous devez également envoyer les fichiers image, ou le 
destinataire ne pourra pas voir les images liées. Vous devez garder une trace de 
l'emplacement des images et vous assurer que le destinataire sache où les déposer sur 
une autre machine, pour que le document Calc puisse les retrouver. Par exemple, vous 
pouvez conserver les images dans un sous-dossier appelé Images (dans le dossier qui 
contient le document Calc) ; le destinataire du fichier Calc devra déposer les images dans 
un sous-dossier qui porte le même nom (dans le dossier qui contient le document Calc).

Note

Si vous insérez la même image plusieurs fois dans un document, vous pouvez 
penser qu'il est intéressant de créer des liens. Cependant, ce n'est pas 
nécessaire, parce que LibreOffice n'incorpore qu'une copie du fichier image dans 
le document. (La suppression d'une ou plusieurs copies n'affecte pas les autres.)

Incorporer des images liées
Si vous aviez au départ lié les images, vous pouvez facilement les incorporer (enregistrer dans le 
document Calc) par la suite si vous le souhaitez, en totalité ou en partie. Pour ceci :

1) Ouvrez le document dans Calc.

2) Choisissez Édition > Liens dans la barre de menus.

La boîte de dialogue Éditer les liens liste tous les fichiers liés. Dans la liste Fichier source, 
sélectionnez les fichiers que vous voulez modifier de lié à incorporé.

3) Cliquez sur le bouton Rompre le lien.

Figure 2 : Boîte de dialogue Éditer les liens

Note
Aller dans l'autre sens, d'incorporé à lié, n'est pas aussi facile : vous devez 
supprimer et réinsérer chaque image, une à la fois, en cochant l'option Lier.
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Insérer une image depuis le presse-papiers
Avec le presse-papiers, vous pouvez copier des images dans un document Calc depuis un autre 
document Calc, un autre composant de LibreOffice (Writer, Draw, …), ainsi que des programmes 
tiers.

Pour ceci :

1) Ouvrez à la fois le document source et le document Calc où vous voulez copier l'image.

2) Dans le document source, sélectionnez l'image à copier.

3) Appuyez sur Ctrl+C pour copier l'image dans le presse-papiers.

4) Basculez dans la fenêtre Calc.

5) Cliquez pour placer le focus à l'endroit où l'image doit être insérée.

6) Appuyez sur Ctrl+V pour insérer l'image.

Attention Si l'application depuis laquelle l'élément graphique est copié est fermée avant que 
cet élément soit collé dans Calc, il peut arriver que l'image stockée dans le presse-
papiers soit perdue.

Insérer une image depuis la Gallery
La Gallery regroupe de façon pratique des objets réutilisables, comme des éléments graphiques 
ou sonores, que vous pouvez insérer dans vos documents.

La Gallery est disponible dans tous les composants de LibreOffice. Elle n'est pas fournie avec 
beaucoup d'éléments graphiques, mais vous pouvez ajouter vos propres images ou trouver des 
extensions qui contiennent plus d'éléments. La Gallery est expliquée en détail dans le Chapitre 11 
(Éléments Graphiques, Gallery et Fontwork) du Guide du débutant. Pour plus d'informations sur 
les extensions, voir le Chapitre 14 (Paramétrer et Personnaliser Calc) dans ce guide.

Cette section explique les bases de l'insertion d'images de la Gallery dans un document Calc.

1) Pour ouvrir la Gallery (Figure 3), cliquez sur l'icône Gallery  (située du côté droit de la 
barre d'outils Standard) ou choisissez Outils > Gallery dans la barre de menus.

2) Naviguez dans la Gallery pour trouver l'image désirée.

3) Pour insérer l'image, faites un clic droit sur l'image et choisissez Ajouter > Copier, ou 
cliquez et faites glisser l'image depuis la Gallery jusqu'à l'endroit désiré au sein du 
document Calc en cours.

Par défaut, la Gallery est ancrée au-dessus de l'espace de travail de Calc. Pour étendre la Gallery, 
positionnez le curseur au-dessus de la ligne qui la sépare du haut de l'espace de travail. Quand le 
pointeur devient un symbole avec des lignes parallèles et des flèches, cliquez et faites glisser vers 
le bas. L'espace de travail est redimensionné en conséquence.

Pour étendre la Gallery sans modifier l'espace de travail, enlevez l'ancrage pour qu'elle flotte au-
dessus de l'espace de travail. Pour ce faire, gardez appuyée la touche Ctrl et double-cliquez en 
haut de la Gallery près des icônes d'affichage, ou appuyez sur la combinaison de touches 
Ctrl+Maj+F10. Renouvelez l'opération pour l'ancrer à nouveau (la ramener à sa position initiale au-
dessus de l'espace de travail).

Quand la Gallery est ancrée, pour la masquer et voir l'espace de travail en entier, cliquez sur le 
bouton Masquer/Afficher au milieu de la ligne séparant la Gallery de l'espace de travail (cerclé 
Figure 3).

Pour fermer la Gallery, choisissez Outils > Gallery pour désélectionner la ligne Gallery, ou cliquez 
à nouveau sur l'icône Gallery.
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Figure 3 : Gallery dans Calc

Modifier des images

Quand vous insérez une nouvelle image, vous pouvez avoir besoin de la modifier afin de l'adapter 
à votre document. Cette section décrit l'utilisation de la barre d'outils Image, le 
redimensionnement, le rognage et une astuce pour faire pivoter une image. Les modifications 
faites dans Calc n'affectent pas l'image d'origine, qu'elle soit incorporée ou liée.

Calc fournit plusieurs outils pour travailler avec les images. Ces outils sont suffisants pour les 
besoins ordinaires de la plupart des utilisateurs. Cependant, pour obtenir des résultats 
professionnels, il est préférable d'utiliser un programme de manipulation d'images tel que GIMP 
pour modifier les images (par exemple, pour rogner, redimensionner, faire pivoter et changer les 
valeurs de couleurs) et ensuite insérer le résultat dans Calc. GIMP est un programme graphique 
libre qui peut être téléchargé depuis http://www.gimp.org/downloads/.

Utiliser la barre d'outils Image
Quand vous insérez une image ou en sélectionnez une déjà présente dans le document, la barre 
d'outils Image apparaît. Vous pouvez la paramétrer pour qu'elle soit toujours présente (Affichage 
> Barre d'outils > Image). Les boutons de contrôle d'image de la barre d'outils Image peuvent 
également être ajoutés à la barre d'outils Standard. Voir Chapitre 14 (Paramétrer et Personnaliser 
Calc) pour plus d'informations.

Cette barre d'outils peut être soit flottante, soit ancrée. La Figure 4 montre la barre d'outils Image 
flottante. Une courte explication des outils est fournie dans la table 1. Voir le Guide Draw pour des 
explications plus détaillées.

Deux autres barres d'outils peuvent être ouvertes depuis celle-ci : la barre d'outils Filtre graphique, 
qui peut être détachée et placée n'importe où dans la fenêtre, et la barre d'outils Couleur, qui 
s'ouvre en tant que barre d'outils flottante séparée.
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Avec ces trois barres d'outils, vous pouvez appliquer de petites corrections aux éléments 
graphiques ou obtenir des effets spéciaux.

Figure 4 : Barre d'outils Image

Table 1. Fonctions de la barre d'outils Image (de gauche à droite)

Icône Nom Effet

À partir d'un 
fichier

Utilisez cette icône comme indiqué dans “Insérer un 
fichier image” page 4.

Filtrer Affiche la barre d'outils Filtre graphique. Voir page 10.

Mode Graphique
Comporte plusieurs modes de couleur dans la liste 
déroulante. Voir page 10.

Couleur Ouvre la barre d'outils Couleur, décrite page 11.

Transparence
Détermine la transparence de l'image sélectionnée. Voir 
page 11.

Ligne Ajuste le style de bordure de l'image sélectionnée.

Remplissage
Remplit la zone avec la couleur ou le motif 
sélectionnés.

Ombre Ajoute une ombre aux côtés de l'image.

Rogner l'image
Ouvre la boîte de dialogue Rogner, où vous pouvez 
supprimer une partie de l'image. Voir page 11.

Changer 
d'ancrage

Bascule entre l'ancrage de l'image à la cellule ou à la 
page. Voir page 21.

Envoyer à l'avant
Envoie l'image sélectionnée sur le dessus de la pile. 
Voir page 20.

Envoyer à 
l'arrière

Pousse l'image sélectionnée au fond de la pile. Voir 
page 20.

Au premier 
plan/À l'arrière-
plan

Permet à l'image de flotter au premier plan ou de faire 
partie de l'arrière-plan (derrière les cellules). Voir page 
20.

Alignement
Si deux images ou plus sont sélectionnées, ajuste 
l'alignement horizontal ou vertical des images entre 
elles. Voir page 22.
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Choisir un mode graphique
Vous pouvez changer la couleur des images en niveaux de gris en sélectionnant l'image, puis en 
sélectionnant Niveaux de gris dans la liste Mode Graphique.

Table 2. Modes graphiques

Mode Graphique Effet

Par défaut Conserve l'image telle qu'elle a été insérée.

Niveaux de gris Affiche l'image avec des niveaux progressifs de gris.

Noir/Blanc Convertit l'image en une image monochromatique noire et blanche.

Filigrane Transforme l'image en un filigrane qui se fond dans l'arrière-plan.

Utiliser les filtres graphiques

Cliquez sur l'icône Filtrer  pour afficher la barre d'outils Filtre graphique, 
qui fournit des outils pour appliquer des filtres élémentaires de photographie et 
d'effets aux images depuis Calc. Pour détacher cette barre d'outils et la placer 
n'importe où sur l'écran, cliquez sur les trois lignes parallèles et faites glisser.

Table 3. Filtres graphiques et leurs effets

Icône Nom Effet

Invertir Inverse les couleurs de l'image à la façon d'un négatif.

Adoucir Applique un flou gaussien à l'image pour en adoucir les arêtes.

Augmenter la 
netteté

Augmente la netteté de l'image.

Supprimer les 
interférences

Applique une grossière réduction de bruit.

Solarisation
Inverse certaines tonalités, ce qui produit un soulignement accentué 
des zones en évidence.

Vieillissement Applique un filtre sépia.

Poster
Ouvre une boîte de dialogue pour déterminer le nombre de couleurs à 
postériser. Cet effet repose sur la réduction du nombre de couleurs. Il 
fait ressembler des photos à des peintures.

Pop'art Applique un style Pop Art à l'image.

Dessin au 
fusain

Applique un style de dessin au fusain à l'image.

Relief
Ouvre une boîte de dialogue pour créer des reliefs. Vous pouvez 
choisir la position de la source de lumière imaginaire qui détermine le 
type d'ombre.

Mosaïque
Assemble de petits groupes de pixels en zones rectangulaires de 
même couleur. Plus les rectangles sont grands, moins l'image 
graphique a de détails.
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Attention

Appliquer consécutivement plusieurs filtres d'image LibreOffice aura pour 
conséquence la dégradation progressive de la qualité de l'image. Les filtres 
d'image de Calc utilisent des algorithmes dits destructifs, avec lesquels chaque 
filtre est appliqué à l'image immédiatement, changeant ainsi les données d'origine. 
Des transformations successives conservent de moins en moins les données de 
départ, ce qui compromet la qualité de l'image insérée. Ce peut être acceptable 
pour des documents simples, mais l'usage de logiciels spécialisés dans l'édition 
de photos et d'images est vivement recommandé pour des manipulations plus 
complexes.

Ajuster les couleurs
Utilisez la barre d'outils Couleur pour ajuster indépendamment les canaux rouge, 
vert et bleu de l'image, ainsi que sa luminosité, son contraste et son gamma.

Définir la transparence

Modifier la valeur de pourcentage dans le champ Transparence  de la 
barre d'outils Image va rendre l'image plus ou moins transparente. Ce peut être utile 
quand vous créez un filigrane ou lorsque vous déplacez une image en arrière-plan.

Personnaliser les lignes, les remplissages et les ombres
Les icônes Ligne, Remplissage et Ombre ouvrent des boîtes de dialogue où vous pouvez 
personnaliser ces éléments. Les détails sont dans le Guide Draw.

Rogner les images
Si vous êtes intéressé seulement par une partie de l'image pour l'objectif de votre document, vous 
pouvez vouloir en rogner (couper et enlever) certaines parties. L'interface utilisateur de Calc pour 
rogner une image n'est pas très évidente, et il est peut-être plus judicieux d'utiliser le module Draw 
ou un logiciel graphique.

Astuce

Pour utiliser l’outil de rognage de Draw, coupez votre image dans Calc, créez un 
nouveau document Draw et collez votre image à l'intérieur. Dans Draw, cliquez sur 

le bouton Rogner l'image  et ajustez à la souris le rognage à l’aide des 
poignées rouges. Puis coupez votre image modifiée dans Draw et collez-la dans 
Calc.

Cliquez sur l'icône Rogner l'image  pour ouvrir une boîte de dialogue où vous pouvez 
sélectionner une portion de l'image à afficher. 

Il n'est pas possible d'utiliser la souris pour sélectionner la zone à rogner, comme vous pouvez le 
faire dans Draw. Au lieu de ça, dans la boîte de dialogue Rogner, spécifiez à quelle distance des 
bordures du haut, du bas, de gauche et de droite de l'image le rognage doit avoir lieu, comme 
illustré Figure 5. Dans l'aperçu, notez que la sélection après rognage est mise en évidence avec 
un rectangle.

Modifier des images 11



Dans la boîte de dialogue Rogner, vous pouvez contrôler les paramètres suivants :

Conserver l'échelle / Conserver la taille de l'image
Quand Conserver l'échelle est coché (par défaut), le rognage de l'image ne change pas son 
échelle.

Quand Conserver la taille de l'image est coché, le rognage élargit (pour les valeurs de 
rognage positives), comprime (pour les valeurs de rognage négatives) ou distord l'image pour 
que sa taille reste inchangée.

Gauche, Droite, Haut et Bas
L'image est rognée de la quantité saisie dans ces champs. Par exemple, une valeur de 3cm 
dans le champ Gauche enlève 3 cm du côté gauche de l'image.

• Quand Conserver l'échelle est coché, la taille de l'image change également ; dans cet 
exemple, la largeur est réduite de 3 cm. 

• Quand Conserver la taille de l'image est coché, la partie restante de l'image est élargie 
(quand vous saisissez des valeurs de rognage positives) ou comprimée (quand vous 
saisissez des valeurs de rognage négatives) pour que la largeur et la hauteur de l'image 
restent inchangées.

Figure 5 : Boîte de dialogue Rogner
 

Largeur et Hauteur
Les champs Largeur et Hauteur sous Échelle ou Taille de l'image se modifient en fonction des 
valeurs des champs Gauche, Droite, Haut et Bas. Utilisez l'aperçu à côté de ces champs pour 
déterminer les valeurs correctes avec lesquelles rogner l'image.

La forme rognée est toujours un rectangle ; les formes plus complexes ne sont pas possibles avec 
Calc. Si vous en avez besoin, utilisez un logiciel spécialisé dans l'édition de photos et d'images, 
puis importez l'image dans Calc.
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Note
Si vous rognez une image dans Calc, l'image elle-même n'est pas modifiée. Si 
vous exportez le document en HTML, l'image d'origine est exportée, et non l'image 
rognée.

Redimensionner une image
Pour redimensionner une image :

1) Cliquez sur l'image, si nécessaire, pour afficher les poignées vertes de 
redimensionnement.

2) Positionnez le pointeur de la souris au-dessus d'une de ces poignées vertes. Le pointeur 
se change en une forme qui donne une représentation graphique (flèche double) de la 
direction du redimensionnement.

3) Cliquez et faites glisser pour redimensionner l'image.

4) Relâchez le bouton de la souris quand vous êtes satisfait de la nouvelle dimension.

Les poignées de coin redimensionnent à la fois la largeur et la hauteur d'un objet graphique 
simultanément, tandis que les quatre autres poignées ne changent qu'une dimension à la fois.

Astuce
Pour conserver les proportions d'origine de l'élément graphique, utilisez Maj+clic 
sur l'une des poignées de coin, puis faites glisser. Faites attention de relâcher le 
bouton de la souris avant de relâcher la touche Maj.

Redimensionner une image bitmap (matricielle) comme une photo affecte négativement sa 
résolution, en provoquant un certain flou. Il est préférable d'utiliser un logiciel spécialisé pour 
dimensionner correctement votre image avant de l'insérer dans votre document, si c'est possible.

Pour un redimensionnement plus précis, utilisez la boîte de dialogue Position et taille, comme 
décrit page 13 ci-dessous.

Utiliser le menu contextuel d'une image

Beaucoup d'options accessibles depuis la barre d'outils Image peuvent également être atteintes en 
faisant un clic droit sur l'image pour ouvrir un menu contextuel. Des options supplémentaires ne 
sont disponibles que dans ce menu ; elles sont décrites dans cette section.

Texte
Ouvre une boîte de dialogue où vous pouvez paramétrer les options pour le texte qui recouvre 
l'image. Pour écrire un texte sur un élément graphique, cliquez sur ce dernier afin de le 
sélectionner et appuyez sur Entrée (ou double-cliquez). Un curseur apparaîtra alors au centre de 
cet élément graphique. Tout texte saisi fera partie intégrante de cet ensemble graphique ; de ce 
fait, si ce dernier est déplacé, le texte le suivra.

Position et taille
Ouvre la boîte de dialogue ci-dessous, où vous pouvez changer la taille, la position, la rotation, 
l'inclinaison et le rayon d'angle de l'image.
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Figure 6 : Boîte de dialogue Position et taille

Faire pivoter une image
Sélectionnez l'image, puis choisissez Format > Image > Position et taille depuis la barre de 
menus, ou faites un clic droit et choisissez Position et taille dans le menu contextuel.

1) Sélectionner l'onglet Rotation de la boîte de dialogue (voir Figure 7).

2) Dans la section Point de rotation, sélectionnez les positions X et Y du point de pivot, à 
partir des côtés gauche et supérieur, avec les données des champs correspondants, ou 
fixez le point de pivot à l'une de ses positions prédéfinies dans le graphique Paramétrages 
par défaut.

3) Dans la section Angle de rotation, sélectionnez l'angle dans le champ Angle, ou choisissez 
un angle multiple de 45 degrés prédéfini dans le graphique Paramétrages par défaut.

4) Vous pouvez revenir aux valeurs présentes lors de l'ouverture de la boîte de dialogue avec 
le bouton Réinitialiser.

5) Cliquez sur OK pour faire pivoter l'image.
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Figure 7 : Onglet de paramétrage de la rotation d'une image

Taille d'origine
Réinitialise les dimensions de l'image avec les valeurs telles qu'elles étaient définies lors de 
l'insertion de l'image.

Description
Vous pouvez ajouter, en tant que méta-données, un titre et une description à l'image. Cette 
information est utilisée par les outils d'accessibilité (comme un logiciel de lecture d'écran) et en 
qualité d'attributs de type ALT (alternatifs) si vous exportez le document en HTML.

Nom
Vous pouvez affecter un nom personnalisé à l'image, pour pouvoir la retrouver plus facilement 
dans le Navigateur.

Astuce
Si vous collaborez à une équipe pour une vaste publication multi-pages, il peut être 
intéressant de donner aux éléments graphiques et autres objets des noms et des 
descriptions significatifs pour contribuer à une meilleure communication.

Refléter
Reflète l'image horizontalement ou verticalement.
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Assigner une macro
Ajoute une fonctionnalité programmée à l'image. Calc fournit de riches fonctionnalités de macros. 
Les macros sont présentées Chapitre 12 (Macros Calc).

Groupe
Pour regrouper des images :

1) Sélectionnez une image, puis gardez appuyée la touche Maj et cliquez sur chacune des 
autres images que vous voulez inclure dans le groupe. Le “cadre de sélection” invisible 
(avec les huit poignées vertes) s'étend pour inclure toutes les images sélectionnées.

2) Une fois les images sélectionnées, choisissez Format > Grouper > Grouper dans la barre 
de menus, ou placez le pointeur de la souris au-dessus de l'une des images et, quand le 
pointeur n'a plus l'apparence d'une flèche mais d'une flèche à quatre pointes, faites un clic 
droit et choisissez Groupe > Grouper dans le menu contextuel.

Une fois les images regroupées, le menu contextuel fournit d'autres options (Dissocier et Éditer 
le groupe) ainsi que le menu Format > Grouper qui comprend Dissocier et Entrer dans le 
groupe. Pour plus d'informations sur le regroupement, voir le Guide Draw.

Utiliser les outils de dessin de Calc

Calc, comme les autres composants de LibreOffice, recèle toute une palette d'outils pour créer des 
dessins personnalisés. Ce chapitre couvre les options par défaut dans Calc. Pour une explication 
plus détaillée des outils de dessin et de leurs utilisations, voir le Guide Draw.

Généralement, si vous avez besoin de créer des dessins complexes, il est recommandé d'utiliser 
LibreOffice Draw ou un autre programme de dessin.

Pour commencer à utiliser les outils de dessin, choisissez Affichage > Barres d'outils > Dessin. 
La barre d'outils Dessin apparaît en bas de l'écran. Vous pouvez la détacher et la déplacer à un 
endroit plus rationnel dans la fenêtre.

Figure 8 : Barre d'outils Dessin avec les icônes par défaut
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Table 4. Fonctions de la barre d'outils Dessin (de gauche à droite)

Icône Nom Effet

Sélectionner Sélectionne des objets.

Ligne Dessine une ligne.

Rectangle
Dessine un rectangle. Pour dessiner un carré, appuyez sur 
Maj pendant que vous faites glisser.

Ellipse
Dessine une ellipse. Pour dessiner un cercle, appuyez sur 
Maj pendant que vous faites glisser.

Ligne à main levée Dessine une ligne à main levée.

Texte Ajoute une boîte de texte sans bordure.

Légende Dessine une ligne terminée par un rectangle de légende.

Formes de base Ouvre la barre d'outils Formes de base.

Formes des 
symboles

Ouvre la barre d'outils Formes des symboles.

Flèches pleines Ouvre la barre d'outils de formes Flèches pleines.

Organigrammes Ouvre la barre d'outils de formes Organigrammes.

Légendes Ouvre la barre d'outils de formes Légendes.

Étoiles Ouvre la barre d'outils de formes Étoiles.

Points Permet de modifier les points d'un polygone sélectionné.

Galerie Fontwork Ouvre la Galerie Fontwork.

À partir d'un fichier
Insère une image avec la boîte de dialogue Insérer une 
image.

(Dés)activer 
l'extrusion

Ouvre la barre d'outils Paramètres 3D et convertit la forme 
sélectionnée (si possible) en 3D.
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Pour afficher d'autres icônes, faites un clic droit sur la barre d'outils, sélectionnez Boutons 
visibles et choisissez les outils que vous voulez voir apparaître dans la barre d'outils.

Icône Nom Effet

Polygone
Dessine une ligne composée d'une série de segments droits. 
Gardez appuyée la touche Maj pour positionner les nouveaux 
points à des angles de 45 degrés.

Courbe Dessine une courbe de Bézier. 

Arc d'ellipse Dessine un arc.

Secteur d'ellipse

Dessine une forme remplie définie par l'arc d'un ovale et deux 
lignes d'angle dans le document courant. Pour dessiner un 
secteur circulaire, appuyez sur Maj pendant que vous faites 
glisser.

Segment de cercle

Dessine une forme remplie définie par un arc d'ellipse et une 
ligne de diamètre dans le document courant. Pour dessiner 
un segment de cercle, appuyez sur Maj pendant que vous 
faites glisser.

Animation de texte Insère un texte animé.

Si la prise en charge des langues asiatiques est activée (dans Outils > Options > Paramètres 
linguistiques > Langues), deux outils supplémentaires peuvent être ajoutés à la barre d'outils 
Dessin : Texte vertical et Légende verticale.

Pour utiliser un outil de dessin :

1) Cliquez dans le document à l'endroit où vous voulez que le dessin soit ancré. Vous pourrez 
changer l'ancre plus tard, si nécessaire.

2) Sélectionnez l'outil dans la barre d'outils Dessin (Figure 8). Le pointeur de la souris se 
transforme en une croix.

3) Déplacez le pointeur à l'endroit dans le document où vous voulez que le dessin apparaisse 
et glissez-déposez pour créer l'objet de dessin. Relâchez le bouton de la souris. (Certains 
outils ont d'autres impératifs : voir l'Aide ou le Guide Draw pour les détails.)

La fonction de dessin sélectionnée reste active, et vous pouvez donc dessiner d'autres 
objets du même type.

4) Pour arrêter la fonction de dessin sélectionnée, appuyez sur la touche Échap ou cliquez 
sur l'icône Sélectionner (la flèche) de la barre d'outils Dessin.

5) Vous pouvez alors changer les propriétés (couleur de remplissage, type et épaisseur de 
ligne, ancrage et autres) de l'objet de dessin en utilisant soit la barre d'outils Propriétés de 
l'objet de dessin (Figure 9), soit les sélections et boîtes de dialogues atteintes en faisant un 
clic droit sur l'objet de dessin.
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Paramétrer ou changer les propriétés des objets de dessin
Pour paramétrer les propriétés d'un objet de dessin avant de le dessiner :

1) Dans la barre d'outils Dessin (Figure 8), cliquez l'outil Sélectionner .

2) Faites apparaître la barre d'outils Propriétés de l'objet de dessin (Figure 9), si ce n'est pas 
déjà le cas, avec Affichage > Barres d'outils > Propriétés de l'objet de dessin.

3) Dans la barre d'outils, cliquez sur l'icône de chaque propriété et choisissez la valeur que 
vous voulez.

Ces propriétés par défaut s'appliquent uniquement au document et à la session en cours. Elles ne 
sont pas mémorisées quand vous fermez le document, et elles ne s'appliquent pas aux autres 
documents. Les propriétés par défaut s'appliquent à tous les objets de dessin, sauf les objets 
textes.

Pour modifier les propriétés d'un objet de dessin existant, sélectionnez cet objet et continuez 
comme indiqué ci-dessus.

D'autres outils et méthodes pour modifier et positionner des éléments graphiques sont décrits dans 
“Positionner des éléments graphiques” ci-dessous.

1 Ligne 5 Couleur de ligne 9 Changer d'ancrage 13 Alignement

2 Style de flèche 6 Remplissage 10 Envoyer à l'avant

3 Style de ligne 7 Style de remplissage 11 Envoyer à l'arrière

4 Largeur de ligne 8 Tourner 12 Au premier plan/À l'arrière-plan

Figure 9 : Barre d'outils Propriétés de l'objet de dessin

Redimensionner un objet de dessin
Sélectionnez l'objet, cliquez sur l'une des huit poignées qui l'entourent et faites la glisser jusqu'à sa 
nouvelle dimension. Pour un redimensionnement à l'échelle, sélectionnez l'une des poignées de 
coin et gardez appuyée la touche Maj pendant que vous faites glisser la poignée.

Pour un contrôle plus précis de la taille de l'objet, utilisez la boîte de dialogue Position et taille (voir 
“Position et taille” page 13) pour paramétrer la largeur et la hauteur indépendamment. Si l'option 
Proportionnel est cochée, alors les deux dimensions changeront en même temps pour que la 
proportion soit maintenue, permettant ainsi un redimensionnement calculé à l'échelle.

Grouper des objets de dessin
Pour grouper des objets de dessin :

1) Sélectionnez un objet, puis gardez appuyée la touche Maj et sélectionnez les autres objets 
que vous voulez inclure dans le groupe. Le cadre de sélection s'étend pour inclure tous les 
objets sélectionnés.

2) Une fois les objets sélectionnés, placez le pointeur de la souris au-dessus de l'un des 
objets et choisissez Format > Grouper > Grouper dans la barre de menus ou faites un 
clic droit et choisissez Groupe > Grouper dans le menu contextuel.
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Positionner des éléments graphiques

Les éléments graphiques peuvent être positionnés dans LibreOffice Calc pour se combiner et 
construire des éléments plus complexes.

Organiser des éléments graphiques
Les éléments graphiques dans un document Calc sont organisés d'une manière identique à une 
pile de cartes à jouer. Si vous ajoutez des images supplémentaires au document, chaque image 
occupe une nouvelle couche au sommet de la pile. Pour organiser les éléments graphiques, vous 
devez dire à Calc de changer l'ordre des couches dans la pile.

Figure 10 : Effet de disposition des couches

Calc dispose de quatre options de base pour réorganiser la disposition des images. Ces options 
sont accessibles par la barre d'outils Image et par le menu contextuel Disposition de l'image :

Envoyer à l'avant
Place l'image au sommet de tous les autres éléments graphiques ou textes.

Envoyer vers l'avant
Envoie l'image un niveau au-dessus dans la pile (axe Z). Selon le nombre d'objets qui se 
recouvrent, vous pourrez avoir besoin d'appliquer cette option plusieurs fois pour obtenir le 
résultat désiré.

Envoyer vers l'arrière
L'opposé de Envoyer vers l'avant ; envoie l'image sélectionnée un niveau en-dessous dans la 
pile d'objets.

Envoyer à l'arrière
Envoie le graphique sélectionné au niveau le plus bas de la pile, le couvrant ainsi par les 
autres éléments (graphiques et textes).

Au premier plan et À l'arrière-plan
Une image ou un objet de dessin peut être également envoyé à l'arrière-plan. Ce n'est pas la 
même chose que Envoyer vers l'avant ou Envoyer vers l'arrière, qui fixent l'ordre d'un certain 
nombre d'éléments graphiques qui se recouvrent. Cette fonctionnalité repousse l'élément 
graphique derrière les cellules, ce qui permet de les modifier sans affecter cet élément.

Un élément graphique en arrière-plan a une entrée de menu Au premier plan, au lieu de À 
l'arrière-plan.
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Ancrer des éléments graphiques
Les ancres indiquent à un élément graphique comment rester en relation avec les autres éléments.

Ancrer à la page
Ancrer un élément graphique à la page lui permet d'être positionné à un endroit particulier de la 
page. L'élément ne bouge pas quand des cellules sont ajoutées ou supprimées. C'est 
l'équivalent d'une référence absolue. L'élément graphique restera toujours en cellule B10 si 
c'est là qu'il a été placé.

Ancrer à la cellule
Ancrer un élément graphique à une cellule permet de s'assurer que cet élément restera 
toujours avec le contenu auquel il a été associé à l'origine. Si un élément graphique est ancré à 
la cellule B10 et une nouvelle ligne est insérée au-dessus, l'élément graphique sera alors ancré 
à la cellule B11. C'est l'équivalent d'une référence relative.

Par exemple, Figure 11, l'image de gauche est ancrée à la cellule B2 (dans laquelle on a saisi XXX 
pour indiquer où l'image est ancrée). L'image de droite est ancrée à la page.

Figure 11 : Ancrage – avant insertion

Si deux lignes sont insérées au-dessus des images, l'image ancrée à la cellule va descendre de 
deux lignes et l'ancrage changera. L'image ancrée à la page ne bougera pas. Ceci est illustré 
Figure 12. Notez que le symbole d'ancrage et que les XXX sont descendus cellule B4.

Figure 12 : Ancrage - après insertion
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Aligner les éléments graphiques
Vous pouvez aligner plusieurs éléments graphiques les uns par rapport aux autres. Pour ceci :

1) Sélectionnez tous les éléments graphiques à aligner (Maj+clic sur chacun). Les éléments 
seront entourés par un cadre de sélection avec huit poignées vertes.

2) Dans la barre d'outils Image, cliquez sur l'icône Alignement et cliquez sur l'une des six 
options.

Ou encore, positionnez le pointeur de la souris au-dessus de l'un des éléments. Quand le 
pointeur devient une flèche à quatre pointes, faites un clic droit et choisissez Alignement, 
puis l'une des six options.

Parmi les six options, trois concernent l'alignement horizontal (gauche, centré, droite) et trois 
concernent l'alignement vertical (en haut, centré, en bas).

Créer une image map

Une image map définit les zones cliquables d'une image, avec des hyperliens vers des adresses 
web, d'autres fichiers sur l'ordinateur ou d'autres parties du même document. Les zones cliquables 
sont les équivalents graphiques des textes avec hyperliens. Si vous cliquez dans une zone 
cliquable, Calc va ouvrir la page liée avec le programme approprié (par exemple, le navigateur par 
défaut pour une page HTML ; LibreOffice Calc pour un fichier .ods ; un lecteur PDF pour un fichier 
PDF). Vous pouvez créer des zones cliquables de différentes formes et inclure plusieurs zones 
dans la même image.

Pour utiliser l'éditeur d'image map :

1) Dans votre classeur, sélectionnez l'image dans laquelle vous voulez définir des zones 
cliquables.

2) Choisissez Édition > Image Map dans la barre de menus. L'Éditeur d'Image Map (Figure 
13) s'ouvre.

3) Utilisez les outils et les champs de la boîte de dialogue décrite ci-dessous pour définir les 
zones cliquables et les liens dont vous avez besoin.

4) Cliquez sur l'icône Appliquer  pour appliquer les paramétrages.

5) Ceci étant fait, cliquez sur l'icône Enregistrer  si vous souhaitez enregistrer l'image 
map en tant que fichier indépendant, puis cliquez sur la croix dans le coin supérieur droit 
pour fermer la boîte de dialogue.

La zone principale de la boîte de dialogue montre l'image dans laquelle des zones cliquables sont 
définies. Une zone cliquable est identifiée par une ligne montrant sa forme.

La barre d'outils en haut de la boîte de dialogue contient les outils suivants :

• Bouton Appliquer : cliquez sur ce bouton pour appliquer les modifications.

• Icônes Ouvrir, Enregistrer et Sélectionner.

• Outils pour dessiner une forme de zone cliquable : ces outils fonctionnent de la même 
façon que les outils correspondants dans la barre d'outils Dessin.

• Éditer, Déplacer, Insérer, Supprimer des points : outils d'édition avancée pour manipuler 
la forme d'un polygone de zone cliquable. Sélectionnez l'outil Éditer des points pour activer 
les autres accessoires.

• Icônes Annuler et Rétablir.

• Icône Actif : bascule l'état de la zone cliquable sélectionnée de Actif à Inactif.

• Macro : associe une macro à la zone cliquable au lieu de lui associer un simple lien 
hypertexte.
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• Propriétés : paramètre les propriétés de l'hyperlien et permet de lui ajouter un attribut 
Nom.

Figure 13 : Boîte de dialogue pour créer ou modifier une image map

Au-dessous de la barre d'outils, précisez pour la zone cliquable sélectionnée :

• Adresse : l'adresse pointée par l'hyperlien. Vous pouvez également pointer vers une ancre 
dans votre document ; pour le faire, tapez l'adresse dans le format suivant : #nom_ancre 
(voir les astuces ci-dessous).

• Texte : saisissez le texte que vous voulez voir apparaître quand le pointeur de la souris se 
trouve au-dessus de la zone cliquable.

• Cadre : définit où la cible de l'hyperlien doit être ouverte : choisissez entre _blank (ouvre la 
cible dans une nouvelle fenêtre de l'explorateur), _self (ouvre la cible dans la fenêtre de 
l'explorateur active), _top ou _parent.

Astuces

Image Map n'est pas approprié lorsque toute l'image doit être cliquable et doit pointer 
sur un seul lien ; dans ce cas, faites un clic droit sur l'image puis choisissez 
Hyperlien dans le menu contextuel.

L'éditeur Image Map ne dispose pas de navigateur permettant de rechercher et 
sélectionner le document cible. Cliquez dans la barre d'outils Standard sur l'outil 
Hyperlien, sélectionnez le document, copiez-collez l'Url depuis la boîte de dialogue 
Hyperlien vers la boîte de dialogue Image Map.

La valeur _self pour le cadre de la cible fonctionnera correctement dans la plupart 
des cas. Il n'est par conséquent pas recommandé d'utiliser les autres possibilités, à 
moins que cela ne soit absolument nécessaire.
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